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1 Introduction 

1.1 Purpose 
This document provides a comprehensive technical and architectural overview of 
the Groove system and its installation procedures. It also provides brief and 
comprehensive information and instructions on some of the features that can be 
found within Groove. With Groove being a Peer-to-Peer based application, it is 
very important to follow proper installation techniques, otherwise a compatibility 
issue could arise. This document covers the specifications needed by a typical 
Groove user or developer. Development within Groove requires the installation of 
certain additional tools (Groove development kit and toolkit for VS.NET) which 
help to integrate the Groove application development into the respective 
development platform.   

1.2 Scope 
The document begins with a brief description of the Groove architecture and also 
studies some of the important components present within Groove application. It 
also describes the Peer-to-Peer based architecture, which is the basis of Groove, 
and shows graphical representations of the strong security architecture found 
within Groove that makes it a powerful tool for collaborative learning. It then 
proceeds to the steps that need to be followed to set up a Groove workspace on 
your system (installation, creation and injection of tools). This section also 
includes the procedures that need to be followed when developing within the 
Groove environment using Microsoft’s Visual Studio.NET framework. Once the 
installation has been completed, the document then explains the implementation 
steps that need to be followed to start using the workspace using a collaborative 
approach. Finally, the document contains the details of the system requirements 
that need to be satisfied for the efficient running of the Groove application.  

1.3 Definitions, acronyms and abbreviations 
The following definitions, acronyms and abbreviations have been used in this 
document: 

Collaborative learning: An instructional methodology where students work in 
groups to achieve a common academic goal. 

Injection: The term ‘injection’ is similar to ‘installation’ in the sense that it makes 
a component or feature available for use. It is the process of adding data or 
functionality to a Groove account. 

However, injection offers a number of powerful advantages: 

• Any component that you inject becomes part of your Groove account. As a 
result, the same component automatically becomes available on any other 
computer on which you use the same Groove account. 

• Injection does all the installation work for you. When you click a .grv or .vcg 
file, the component simply gets installed. You don't need to specify directory 
paths or run setup programs. 

• Injection usually just requires having an Internet connection or an email 
account. You never need to feed CDs and/or floppy disks into your disk 
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drives. Instead, you just double-click the injection file and let Groove do the 
work. 

Encryption: Encryption is the process of scrambling data so that only the 
intended receiver can use it. To be effective, encryption needs to be used by both 
the sender and the receiver. Users should make sure it is being used when 
sending sensitive information. 

Peer-to-Peer: Establishing a connection from one computer directly onto another 
computer without the need for a server sitting in between to provide the 
connectivity.  

Enterprise Management Server: The Groove Enterprise Management Server 
provides enterprise IT managers with centralized services for administering the 
deployment and use of Groove within the enterprise. It includes facilities for 
usage management and reporting services, security policy management services, 
active directory support etc. 

GDK: Groove platform Development Kit 

GTK: Groove development Toolkit (Groove toolkit for Microsoft 
VisualStudio.NET) 

Groove workspace: Space allocated for you to work on the Groove application. 

Shared workspace: A common workspace on Groove, on which many users can 
access (provided they are invited contacts) and collaborate together with the rest 
of the group within the workspace. 

Passphrase: Similar to a password used for security purposes. 
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2 Description of the Groove architecture and its 
components 

Groove is Internet software for making direct connections with people far and 
near. With Groove, one can talk, chat, instant message, draw pictures, swap 
photos and files, play games and browse the Web together with friends, family 
and co-workers. With Groove, having conversations with context is as easy as 
sending an email or accessing the Web. Groove runs on Windows PCs and uses 
the Internet for communication. It is thus a great Peer-to-Peer tool for 
communication purposes. 

With Groove, groups of business associates, family members, friends or 
acquaintances can work or socialize in a way that is meaningful and natural, and 
with complete security and control over the group's activity and content. If a 
browser is what people use to interact with pages on a Web site, Groove will 
become the way people interact directly with other people in Groove shared 
spaces. 

Some of the key features provided by Groove are as follows: 

• Instant text and audio messaging. Instant messages can also be invitations 
to participate in other Groove activities, such as participating in shared 
spaces or conversation spaces. 

• Shared spaces. A shared space is an online collaboration room where you 
and other people can share far richer activities than simple messaging. A few 
examples of activities people might do in a shared space include: 

 planning a reunion for a family or group where people live in different 
locations 

 collaborating on a project without team members ever meeting face-to-
face, or 

 an ongoing virtual club-meeting for any variety of clubs where sharing 
things like documents and schedules is a constant necessity. 

• Collaboration. The ability to collaborate and share information regardless of 
time or Internet online status. You can be active in any shared space you are 
a member of at any time, regardless of whether other members are active or 
online. You can also be active in a shared space even if you are not 
connected to the Internet. The next time you connect, your updates and 
additions are automatically added to the shared space. For example, while 
flying home from a meeting, you might add responses to a collection of 
discussion documents. When you next connect your laptop to the Internet, all 
of your responses are automatically added and shared with all other 
members of the shared space. 

• Extensibility. As a software platform, Groove is highly extensible. You can 
continually enhance your experience using Groove by injecting new and 
upgraded components. These components may include new or improved 
tools you can add to your shared spaces. In addition to tools, you may also 
inject new contacts, shared space invitations, and even your Groove account 
itself (if you want to use your Groove account on multiple computers). 
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Finally, a Groove administrator can create Groove licenses and make these 
available for employees to inject into their Groove accounts. 

 

• Privacy. For Groove members, all communications are private as they take 
place only between yourself and other members of a shared space. As an 
additional privacy feature, you can assume multiple identities so that you can 
interact with different people using a different persona. For example, you 
might be ‘Kathleen Doe’ when using Groove for business activities, ‘KathyD’ 
when talking with friends, and maybe ‘Mom’ when talking with your kids. 

 

• Security. Whenever possible, Groove avoids storing your data on servers. 
Instead, your data is transmitted directly to the other people in the same 
shared space. A copy of this data is stored on each user's computer (not on a 
server where you don't have control over it). Groove automatically and 
securely distributes and saves data that group members produce during their 
interactions. 
In instances where Groove does need to store your data on a server (for 
example, if you are transmitting data to someone who is not online, your data 
is encrypted such that it is unreadable on the server.  
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3 Architectural representation 
 
Sharing of data over a collaborative environment using Groove is secure and 
easy. Groove facilitates the sharing of data and computational resources quickly 
and securely among those who need it – anywhere, anytime, any way. Users can 
create ad-hoc collaborative places known as ‘shared spaces’ without 
cumbersome administrative intervention and can do so on demand. It also allows 
users to invite people (almost instantaneously, whether they are across the table 
or from any part of the world) to join the shared space by dynamically introducing 
data and tools to the space. The other advantage of using Groove is its very 
effective firewall. Groove uses standard web protocols to avoid requiring network 
administrators to open special ports in the firewall. In addition, organizations can 
deploy Groove servers for centralised management and control of Groove usage.  
 
Groove’s security features enhance collaboration in the following ways: 

• Groove enables secure, cross-firewall collaboration 
• Security features are transparent to the user 
• Groove encrypts all content on disk and over the network 
• User driven shared space access control 

Below is a graphical representation of the security architecture within Groove: 
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All information related to a user’s account is handled by the Enterprise 
Management Server. During account enrolment, the Enterprise Management 
Server creates a one-time account activation code that the user account and 
Management Server use to establish a secure communication link with the user 
during account enrolment. This account information (and other managed identity 
information) is initially passed to the user out-of-band using some secure method 
such as trusted email or person-to-person transfer. 
 
The below architecture shows the process of account enrolment within the 
managed environment: 

 

Figure Key: 

1 – K is the key created by Hashing the account activation code 
2 – The Enterprise Management Server acts as a Certifying Authority (CA) as 

it signs managed-identity public keys (contact information) to create 
certificates. 
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4 Deployment of Groove Workspace 

4.1 Installing Groove Workspace 
 
If you install Groove Workspace from the Groove web page (www.Groove.net), 
you can choose installations between the free Groove Workspace Preview 
Edition, and the licensed Groove Workspace Standard or Groove Workspace 
Professional editions.  
 
To install Groove Workspace: 
1. Make sure your computer satisfies the system requirements (refer to the 

‘system requirements’ section) 
2. Go to the ‘Products’ page on groove.net. 
3. Do one of the following: 

• Click Buy Now to see options for purchasing Groove Workspace 
Standard or Groove Workspace Professional, as well as a description of 
feature differences among Groove Workspace editions. 

• Click Try Now to see information and options for downloading the free 
Groove Workspace Preview edition. 

(or) 

If you are installing Groove Workspace from a CD, insert the CD into the drive 
and follow the instructions displayed on the screen. 
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4.2 Creating a licensed Groove Workspace account 
 
If you have installed Groove Workspace Standard Edition or Groove Workspace 
Professional Edition, an activation key must be used to create a new account. 
Usually, each new account created must have its own key. Typically, activation 
keys are distributed by email. If the Groove software was provided to you by your 
employer or organisation, you should receive an email containing your activation 
key from your Groove administrator. If you purchased a Groove license on your 
own, you should receive an email containing your activation key from Groove 
Networks. In addition to the activation key, these email messages include 
instructions for installing or updating Groove and activating an account. 

If you currently have a Groove Preview Edition account, you can use the 
activation key to change this to a licensed account. You can create a new Groove 
Workspace Standard Edition or Workspace Professional Edition account using 
the Product Activation wizard. 
You must be online to create an account. To create a new account, do the 
following: 
1. Install and start Groove as described in the email message. 
2. Start the product activation wizard. 

If you have no existing accounts, the product activation wizard starts 
automatically and steps you through the account creation process. 
If you already have an account, do not log into it if prompted to do so. 
To start the product activation wizard, select ‘New Account...’ from the Groove 
taskbar menu: 

 
3. Copy your activation key from the email message and paste it into the 

‘Activation Key’ data entry field or enter the same into the field. Click ‘Next’. 
4. If Groove displays the license agreement, accept it and click ‘Next’. 
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5. When prompted, enter a name for the account. You may enter any name you 
choose. You may also change the name later after the account is created. If 
the account name is completed for you, you were supplied a managed 
identity. 
In either case, your account name is your initial identity (display name) by 
which people will recognise you. 

6. Set a passphrase to keep your Groove account secure. 
Many employers or organizations set policies that determine if a passphrase is 
required and how complex it must be. If the passphrase you enter does not 
meet these requirements, Groove will ask you to enter a different passphrase 
before creating your account. Also, if you want to avoid typing your 
passphrase each time you start your computer and open Groove, check 
‘Remember my passphrase on this computer.’ Depending on policies, this 
option may not be available. But, beware: if you check this option, other 
people can access your Groove account without a passphrase on this 
computer. Use this option only if you are sure no one else will use your 
computer.  

7. If you only want people to be able to find your Groove contact, accept the 
option ‘List my name in the Groove.net public directory’. If you list your name 
in the Groove.net public directory, other Groove users will be able to find your 
contact information quickly and start Groove activities with you.  If you 
uncheck this option but change your mind later, you can still list your Groove 
contact information in ‘My Account’. 

8. Click ‘Finish’. 
By following the above steps you will have allowed Groove to create your 
account with the name and passphrase you specified.  Your account will have 
one identity, your default identity, which has the same name as your account. 
In addition, by default, Groove adds a sample shared space called ‘Welcome 
Space’ to your account. To go to this shared space, double-click it in ‘My 
Spaces’, or select ‘View → Go To → Welcome Space’ from the ‘View’ Menu. 
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4.3 Injecting new components into Groove 
 
Being a software platform, Groove is highly extensible. You can continually 
enhance your experience, using Groove by injecting new and upgraded 
components. These components may include new or improved tools you can add 
to your shared spaces, contacts, shared space invitations, and even your Groove 
account itself if you want to use your Groove account on multiple computers. As a 
rule of thumb, any file that has a .grv (Groove file) or .vcg (Groove vCard file) 
extension can be injected into your Groove account. Basically, these are the files 
associated with your workspace that can be saved and reused. 
 
For security reasons, new components are always injected into a single Groove 
account. That is, if you have more than one Groove account on your computer (or 
if, perhaps, you are sharing a computer with other people who have Groove 
accounts), you cannot inject a new component into all accounts simultaneously. 
On clicking any injectable file under these circumstances, Groove first opens a 
Login dialog box in which you need to enter the passphrase for the selected 
account (enter your Groove passphrase if prompted). 
 
Injecting contacts 
Groove contacts may send you their vCard (.vcg) file as a file attachment. 
Alternately you may download Groove vCard files from the public directory on 
Groove.net. When you open the file attachment or download a vCard file from 
Groove.net, the new contact gets added to ‘My Contacts’ 
 
Injecting shared space invitations 
You may receive an invitation to a shared space as a file attachment in an email, 
or an administrator may place a shared space invitation file on a file server or 
Web site. In either case, a shared space invitation is a file that contains the name 
of the shared space and has a .grv file extension. When you open this file, the 
invitation gets injected into your Groove account, and the ‘Respond to Invitation’ 
dialog box opens. 
 
Injecting your Groove account 
You can save your Groove account as a .grv file that you can open to inject your 
Groove account onto another computer that already has Groove installed but on 
which you do not yet have your Groove account.  
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4.4 Starting Groove 

Starting Groove depends on which options you selected during installation. You 
can choose to have an icon placed on your desktop or to have Groove start 
automatically when you start your computer. If either of these options have not 
been selected, you can start Groove from the Windows ‘Start’ menu. 
 
To start Groove: 
1. Click ‘Start’, then select ‘Programs → Groove → Groove’ or double-click the 

Groove icon. If there are multiple Groove accounts on this computer, Groove 
displays the ‘Groove Select Account’ dialog box. If there's only one account on 
this computer, Groove displays the ‘Groove Login’ dialog box. 

 
2. If you see the ‘Groove Select Account’ dialog box, select the Groove account 

you want from the ‘Name’ drop-down list. 
 
3. Type in your passphrase. 

(Note: If you didn't set a passphrase for your account, you will not see the 
passphrase text box.) 
 

4. Enter your passphrase. 
 
5. Click ‘Select’ if you selected an account from the drop down list or ‘Login’ if 

there is only one account on this computer and click ‘Login’. 
By following the above procedure, Groove will start and open a transceiver. 

4.5 Shutting down Groove 

To shut down Groove completely and log off all accounts, click the Groove 
taskbar icon and select the ‘Shut Down Groove’ option. 
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4.6 Installing Visual Studio.NET  

You can install either Microsoft’s Visual Studio.NET 2002 or Microsoft’s Visual 
Studio.NET 2003 version onto your system.  
 
Note: We have used the VS.NET 2002 GDK for our development. 

4.7 Installing the Groove Development Kit (GDK) 

The Groove Development Kit (GDK) is used to develop customised Groove tools 
or to enhance existing tools. It contains all the essential details and tools needed 
to start developing in Groove. GDK can be obtained free of cost from the Groove 
website (www.groove.net)  

The GDK provides for the following: 

• sample code in popular programming languages  
• comprehensive API documentation  
• utilities and tools to help you to quickly begin creating customized tools, 

and  
• documentation and samples for integration, enabling development of 

extended enterprise solutions  
 
System Specifications 
 

• Basic requirements for Groove Preview Edition (refer to the system 
requirements) 

• For Visual Basic samples, Visual Basic 6.0 Service Pack 3 is required 
• For Visual C++ samples, Visual C++ 6.0 Service Pack 3 is required 
• For script samples, Visual Interdev is recommended 
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From the Groove webpage, select the ‘Products → Developers Tools’ option. The 
system will display the Developers Tools screen (as shown below). Now click on 
the Groove Platform Development Kit (GDK) link and click on the ‘Download’ 
option to start the download of the GDK to your system. 

 

 
 
 
The system will then download the GDK. The GDK is a complete package 
including documentation, registry settings, working samples in Visual C++, VB 
and Java and the Groove developer tools. 
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4.8 Installing the Toolkit for VS.NET 

The Groove Toolkit for Microsoft Visual Studio .NET (the GTK) provides access to 
Groove reusable components within the familiar Visual Studio integrated 
development environment.  The GTK makes it easy for developers to build 
Groove tools using existing programming skills and resources. With the GTK, you 
can build deployable Groove applications in VB.NET or C#. 

Groove provides separate versions of the GTK customized for use with either 
Microsoft Visual Studio 2002 or Microsoft Visual Studio 2003. The two versions of 
the GTK are functionally equivalent. You may run the two current versions of the 
GTK side-by-side (with the appropriate VS .NET release). 

Note: We have used the VS.NET 2002 GDK for our development. 

From the Groove webpage, select the ‘Products → Developers Tools’ option. The 
system will display the Developers Tools screen (as shown below). Now, click on 
the Groove Toolkit for Microsoft Visual Studio.NET (GTK) link. Then select either 
Visual Studio 2002 or Visual Studio 2003 version and click on the ‘Download’ 
option to start the download of the GDK on to your system.  
 

 

The system then downloads the GTK installer onto your system. Run the 
executable to complete the installation. 
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5 Implementation steps 

5.1 Creating a Groove workspace 

The following steps help you to create a new workspace in Groove. Every shared 
workspace contains a collection of tools which the user can choose to be 
displayed within the newly created workspace. Tools can be removed and added 
anytime, provided that sufficient permissions are set. 
 
Step 1: 
Run the Groove application. Select the ‘File → New → Shared Space’ sub menu 
option to start the create space wizard. 
 
Step 2: 
The ‘Create Shared Space’ dialog window allows you to either select your custom 
tools or to select the standard toolset option to get a default set of tools loaded on 
to your workspace. Click on the ‘Next’ button to proceed. 
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Step 3: 

Once you have selected your choice of tools, enter a suitable name for the 
shared space. Select the ‘Invite no one at this time’ option and click on the ‘Next’ 
button. 

Note: It is always advisable to invite people after completing the creation of a 
space.  
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Step 4:  

The screen then asks you to choose a ‘Groove Workspace Compatibility’ option. 
Select ‘2.5 Workspace’ and then click on the ‘Next’ button. 
 
 

 
 
Step 5: 

Now, click the ‘Finish’ button on the create space wizard to complete the creation 
of a shared space. Groove will now create and open the shared space. 

The shared space that has been created is now ready to be used. Contacts can 
now be invited into the workspace to begin a collaborative exchange. Additional 
tools can be added or removed according to need.  
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5.2 Adding a new tool to the shared workspace 

Collaborative learning may need new tools to be added and removed with the 
flow. It is very easy to add or remove tools using Groove Workspace. 
To add new tools, follow the steps outlined below: 
Step 1: 
Click on the ‘Add tools’ tab (which is normally located in the right corner) 
Step 2: 
Select the required tool(s) from the available list of tools. 
Step 3: 
Click on ‘Add Selected Tool’ button. 
The new tool is added to the left of the ‘Add Tool’ tab. 
Note: To move tools from one tab to the another, drag and drop the tool to the 
required location. 

5.3 Removing a tool from the shared workspace 

Right click on the tab for the tool to be removed and select the ‘Delete tool’ 
option. 
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5.4 Inviting people to the shared workspace 
Inviting users to join the shared space can be done using the Groove contact of 
the user or through email address. You can also use the instant messaging tool to 
invite users.  
Inviting by email  
This method is normally used to invite users who are not yet running Groove or 
who do not have a Groove contact created yet. This invitation to users arrives in 
the form of an email message with a Groove invitation file attachment. The 
recipient user has to open the attachment to accept the invitation. 
Step 1. 
To invite a user by email, follow the steps below: 

• Click on the ‘Invite’ option from the shared space. The ‘Send Invitation’ 
window will pop up.  

• Click on ‘Recipients’ to open the ‘Add Recipients’ window. 
• Click on the ‘Look in’ drop down list box and select the ‘Enter an email 

address.’ option. 
• Enter the email address of the user into the ‘Email Address’ field and click 

on ‘Add’ button. 
• Click on the ‘OK’ button which displays the added address into the ‘To:’ field 

in the ‘Send Invitation’ window. By default, standard steps on how to get 
Groove are included in the message field. You can also include your own 
message. 

• Finally click on the ‘Send Invitation’ option. 
Groove sends the email invitation. Recipients who are already running Groove 
can open and accept the invitation immediately. Other recipients must first install 
Groove and activate an account before opening and accepting the invitation. 
Inviting by instant message 
This is the easiest way to invite people into your shared space provided you have 
the users Groove contact or can find it in a search directory. 
Step 2. 
To invite a user by instant message, follow the steps below: 

• Click on the ‘Invite’ option from the shared space. The ‘Send Invitation’ 
window will pop up.  

• Click on ‘Recipients’ to open the ‘Add Recipients’ window and browse 
through the search directories. 

• Click on the ‘Look in’ drop down list box and select a search directory. 
• Search for the user/contact in the selected search directory. On retrieving 

the required user contact, click on the ‘Add’ option. 
• Click on the ‘OK’ button. The selected contact’s name and addresses 

appear in the ‘To:’ field in the ‘Send Invitation’ window. 
• Click on ‘Send Invitation’ option after typing any message (optional).  
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6 System requirements 

6.1 Operating system 

• Microsoft Windows 98/2000/ME/XP 
• Microsoft Windows NT 4.0 (with service pack 5 or later) 

6.2 Hardware requirements 

• 400 MHz Intel Pentium processor or higher 
• 128 MB RAM 
• 100 MB available hard disk storage (with 60 MB additional space required 

for user data) 
• Display resolution 800 x 600, 15 bit (32,768) colour minimum 
• Sound card, speakers, and microphone required to use voice features 

6.3 Software requirements 

• Microsoft Internet Explorer 4.0 or later (5.0 or later recommended) 
• Internet Explorer 6.0 required for Groove forms tool, Mobile workspace for 

Microsoft SharePoint and Groove Web Services. 

6.4 Internet connection 

• 56 kbps modem minimum 
• LAN(Local Area Network), DSL or cable modem preferred 
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